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1  

Chapter 1 - Introduction 
StageIT is a simulation program that can be used for: 
 Promotional Testing 
 Fire Tactics Planning 
 Pre-Fire Planning 
 After Action Review 
 Hazmat Training 
 WMD / Terrorism Simulations 

 
StageIT can be used to present simulations where the instructor and students are in a 
classroom setting, students are in remote locations or connected to the instructor via a 
network. 
 
While a basic Media Library is supplied with the system, you can configure the system 
to meet your own requirements. You can take pictures of anything in your local 
response area and create realistic simulations using your own photos, videos, and 
audio files. 
 
There are three components included with StageIT:  
 
 StageIT Instructor - the main module; used by instructors to author and present 

simulations, to manage the Media Library, and to create instructor and student 
notes. 

 StageIT Student – used by students in a networked environment to view 
simulations under instructor control with access to a chat system for interacting 
with the instructor and other students. 

 Iluminar License Manager – controls the licenses used by StageIT Instructor and 
Student. 
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Introduction 

To get started with your new simulator there are 7 basic steps to follow: 
 

1. Install the software – See page 5 Installation 

2. Activate your licenses - See page 16 Licensing StageIT 

3. Install your licenses - See page 16 Licensing StageIT 

4. Create a new simulation file - See page 37 Create a Simulation 

5. Edit and preview your simulation - See page 39 Editing a Stage 

6. Publish your simulation - See page 41 Publish a Simulation 

7. Present your simulation - See page 43 Present a Simulation 

System Requirements 

StageIT Instructor Minimum Requirements 
 Windows Vista, Windows XP Professional, Windows XP Media Center 

Edition, Windows 2000 
 1.7 GHz processor or better 
 512 MB RAM or more 
 5 GB Hard Disk Space or more if available 
 Video Display Adapter that supports DirectX 9.x or better  
 Windows Media Player 9.x or better 
 DirectX 9.x or better 

 
Windows Vista Home Basic and Windows XP Home will run in Demo mode 
only. (See page 5 Demo Installation for details). 

StageIT Instructor Recommended Requirements for Best Performance 
 Windows Vista, Windows XP Professional, Window XP Media Center Edition 
 Pentium® D Processor 820 w/Dual Core Technology, 2.80 GHz or better 
 1 GB RAM 
 250 GB Serial ATA Hard Drive 
 256 MB Video Card 
 IEEE 1394 Adapter – Firewire card for importing video from a digital video 

camera 
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StageIT Student Minimum Requirements 
 Windows Vista, Windows XP Professional, Windows XP Media Center 

Edition, Windows 2000 
 1.7 GHz processor or better 
 128 MB RAM or more 
 1.5 GB Hard Disk Space or more available 
 Video Display Adapter that supports DirectX 9.x or better  
 Windows Media Player 9.x or better 
 DirectX 9.x or better 

 
Windows Vista Home Basic and Windows XP Home will run in Demo mode 
only. (See page 5 Demo Installation for details). 

License Manager Minimum Requirements 
 Windows Vista, Windows XP Professional, Windows XP Media Center 

Edition, Windows 2003 Server, Windows 2000 
 1 GHz processor or better 
 128 MB RAM or more 
 1 GB Hard Disk Space or more available 
 Internet Information Server 6.x or better 
 ASP.NET 
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2 
 

Chapter 2 - Installation 

StageIT Installation 
 
There are three ways to install the system – Demo, Express and Advanced. Most users 
can use the Express installation, which will install either a Full System or the Student 
version only. Use the Advanced installation method if you want to control which 
components of the system are installed such as directory settings or other installation 
properties. 
 
StageIT requires the following to be installed on your computer.  
 Internet Information Services (IIS), ASP.Net – Required by StageIT License 

Manager 
 Direct X - Required by StageIT Instructor and Student 

The StageIT installation process will install them if they are not found on your system. 
 

Caution: Before installing, it is recommended you turn off all anti-virus 
software. Proper installation cannot be guaranteed if installation takes 
place with anti-virus software running. 

 

Demo Installation 
 
Demo install is used to install a demo version of the software on a stand-alone 
computer for evaluation purposes. The system can be installed for evaluation purposes 
on Windows Vista Home Basic or Windows XP Home Edition, but Vista Home 
Basic and XP Home editions do not support the installation of the License Manager 
component that is required to run a fully licensed copy of StageIT.  
 

  

Normally, a Demo install of the StageIT software can be automatically converted to a 
fully operational system by installing the License Management component and 
activating the software.  This is not possible on a stand-alone system running 
Windows Vista Home Basic or Windows XP Home.  On a Windows Vista Home 
Basic or Windows XP Home system StageIT can only be upgraded to a fully licensed 
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installation if the Vista Home Basic or XP Home edition machine connects to a 
network where the license manager is installed on another computer or server running 
Windows Vista, Windows 2000, Windows 2003 Server, Windows XP Professional, 
Windows XP Media Center Edition. 
 
In Demo mode, all StageIT features are active except for the ability to save or publish 
a simulation. Also, when presenting the demo simulation to a student in demo mode 
only one stage can be shown to the student. 
 
Express Installation 
 
To install StageIT using Express installation: 

1. Insert the StageIT CD. 
2. On the Welcome to StageIT screen, click Express.  
3. On the next screen, click Full System or Student Only. 
4. Before proceeding with the rest of the installation, make sure that all anti-

virus software on your system is disabled, and then click Next. 
5. On the License Agreement screen, review the license agreement, click I 

accept the terms of the license agreement and then click Next. 
6. On the Customer Information screen, type your user information and then 

click Next. 
7. On the Ready to Install screen, click Back to make any changes in previous 

screens or click Next to begin copying files.  Files will be copied to your 
disk drive, installing the software and all related files. This will take a few 
minutes. 

8. A Files Needed window may display; If you see this window click Browse 
and navigate to the drive where the StageIT install CD is located (typically 
the “D” drive). 
 
If not displayed, skip this step. 
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Installation 

 
 For Windows 2000 systems, locate and double-click on this folder: 

 

For Windows XP systems, locate and double-click this folder: 

 

 When the correct file path shows up in the Copy files from field in the Files 
 Needed window, click OK to continue. 
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9. A second Installer window will display, saying that the Web Server will be 

restarted. This will not connect to the Internet or restart your computer. 

 
 

10. Click Yes to continue. 
11. On the Setup Status screen, click Next. 
12. On the Setup Completed screen, click Finish to complete the installation. 
 

Advanced Installation 
 
To install StageIT using the Advanced installation: 
 

1. Insert the StageIT CD. 
2. On the Welcome to StageIT screen, click Advanced.  
3. On the next screen, select the portions of the system to install and click 

Next. 
 
Because StageIT licenses for both StageIT Instructor and StageIT Student 
are floating licenses, you can install either product on as many computers as 
you like. The license manager will limit the use of the software to the 
number of concurrent users permitted by the licenses purchased and installed 
on your system. 
 Note: Only install the license server on one computer. 

4. Before proceeding with the rest of the installation, make sure that all anti-
virus software on your system is disabled, and then click Next. 

5. On the Welcome to StageIT screen, click Next. 
6. On the License Agreement screen, review the license agreement, click I 

accept the terms of the license agreement and then click Next. 
Iluminar Technologies, Inc. StageIT 8  
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7. On the Customer Information screen, type your user information and then 
click Next. 

8. On the Choose Destination Location screen do one of the following:  
 Click Next to accept the default location and proceed. 

-or- 
 Use the Browse button to specify a different installation directory and 

then click Next 
 Files will be copied to your disk drive, installing the software and all related 

files. 
 

9. On the Choose Destination Location for the Media Library screen do one 
of the following: 
 Click Next to accept the default location and proceed. 

-or- 
 Use the Browse button to specify a different installation directory for the 

Media Library and then click Next  
10. On the Required Information screen, select a license server. If the license 

server is going to be this machine, type in the full name for this machine. 
11. Click Browse to change the destination folder for StageIT configuration 

files, if desired, and then click Next.   
12. On the Ready to Install screen, click Next to begin copying files. 

A second Installer window may display, saying that the Web Server will be 
restarted. This will not connect to the Internet or restart your computer. 

 

 
 

13. Click Yes to continue. 
14. On the Setup Completed screen, click Finish to complete the installation. 
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Restoring or Updating StageIT 
 
You can upgrade StageIT to a newer version or restore StageIT to correct behavioral 
issues that can arise from power failures and other unforeseen events. If you do decide 
to restore StageIT, you will also need to reinstall any Add-in components after the 
restore/upgrade procedure. 
 

Note: Add-in components require StageIT version 1.1 or higher. If you are 
running StageIT 1.0 you will need to upgrade before installing Add-in 
components. 

 
To restore or upgrade StageIT: 

1. Insert the StageIT Version 1.1 CD. 
2. An Update/Restore window will appear. Check the boxes to the left of each 

component you wish to upgrade or restore and click OK to continue. 

 
3. The installation will proceed as described above. 

 
Note: If an Instructor has StageIT installed along with an Add-in component 
like ‘Advanced Smoke & Backdraft’, and a StageIT Restore or Upgrade is 
performed, the Add-in information in the Media Library will be lost. The Add-
in component will need to be reinstalled after the restore/upgrade. 
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Add-In Components Installation 
 
Add-in components are additional feature products, or enhancement modules, that can 
be installed into StageIT any time after StageIT is installed.  

Note: Add-in components require StageIT version 1.1 or higher. If you are 
running StageIT 1.0 you will need to upgrade before installing Add-in 
components. See page 10 Restoring or Upgrading StageIT. 

‘Advanced Smoke & Backdraft’ is one such effects module. After installing Advanced 
Smoke you will automatically see the new Media Library components under their 
respective folders in the Media Library. 
 
 To install Add-in components such as Advanced Smoke & Backdraft: 

4. Insert the Add-in component CD. 
5. After the splash screen you’re presented with the End User License 

Agreement. Review the license agreement, click I accept the terms of the 
license agreement and then click Next. 

6. On the Customer Information screen, type your user information and then 
click Next. 

7. On the Ready to Install screen, click Back to make any changes in previous 
screens or click Next to begin copying files.  Files will be copied to your disk 
drive, installing the software and all related files. This will take a few minutes. 

 

Note: After installing Advanced Smoke you will 
automatically see the new Media Library components 
under their respective folders in the Media Library. 

 
Once the add-in component is installed the license for the 
component must be installed. First activate your license for 
the new component. (see page 16 Licensing StageIT for 
details) 
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Once you have activated and received your add-in component license file: 

1. Save the license file on your hard drive in a location you can access. 
2. Reopen the license manager by choosing the File menu, click License 

Management 
3. Click Install License File. 
4. Click Browse, navigate to the location where you saved the license file, click 

the file name, and click Open. 
5. Click Install License File. 

You have completed the licensing process. 
 
Once you have properly licensed the add-in component, licenses will be listed on the 
General tab of the main License Management page. 

 

 
 

Note: After installing the licenses, close StageIT Instructor and then re-open the 
application. This step is necessary for the licenses to become functional. 
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If You Don’t Upgrade StageIT First 
If you attempt to install the add-in component before upgrading StageIT to version 
1.1, this type of “Failed Install” window will appear.  
 

 
 
To remedy this: 

1. Click the Finish button to end the failed installation of the Add-in.  
 

2. Now insert the new StageIT 1.1 CD to begin the upgrade process. See page 10 
for upgrade instructions. 

 
Note: The old version of StageIT does not need to be uninstalled in order to 
upgrade. 

 
3. After successfully upgrading StageIT, you can now install the Add-in 

component. 
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Chapter 3 – StageIT Instructor 
StageIT Instructor is the main module. It is used by instructors to author and present 
simulations, to manage the Media Library, and to create instructor and student notes. 

Starting StageIT Instructor 
 
The first time that StageIT Instructor is started, several cache files of graphics are 
created. This may increase the time it takes to initially launch the application. 
 
Until your licenses are installed, when you open StageIT Instructor, you will see a 
window indicating that the software is not licensed. Click Run in DEMO Mode to 
start StageIT. 

 

Note:  Once licenses are installed, StageIT Instructor will open normally 
without this window.  

 
 

Iluminar Technologies, Inc. StageIT 15  



StageIT Instructor 

Each time you open StageIT Instructor, a new folder and new stage are created, and 
the Organizer window opens in Edit mode, ready to create a new simulation. See 
page 37 Create a Simulation for more information about creating a simulation. 

 

 

Licensing StageIT 
 
Before you can use the full functionality of StageIT, or an add-in component such as 
an effects module, you must activate their licenses. 

To license the software or add-in component: 
1. On the File menu, click License Management. This opens the main license 

management page. 
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2. Click Advanced. 

 

a. If you already have a license file from another Iluminar product such as 
the Iluminar Learning Management System go to step 3. 

b. If you do not have a license file from another Iluminar product, skip to 
step 7. 

3. Click Install License File in the License Management window.   
4. Click Browse and navigate to the location where you saved your other 

Iluminar product license file.   
5. Click the file name and click Open. 

 
6. Click Install License File. 
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7. On the main License Management page, do one of the following: 
 
If Then 
You have Internet 
connectivity 
 

Click on the Internet Activation button 
1. Enter your Activation Number, First Name, Last 

Name, Company Name, Phone Number, and E-
mail Address. 

2. Confirm your E-Mail Address, and click Activate. 
3. You will be redirected to a green success page if 

your activation is successful and your license file 
will be installed into your system automatically. 

4. A copy of your license key file will be sent to you 
via e-mail.  You should save this file in case you 
need it to restore your licenses in the future. 

You have completed activation so skip the rest of the 
steps in the table below. 
 

You do not have Internet 
connectivity 
 

1. Click Telephone Activation. 
2. Call 1-360-779-1179 ext 5 
3. Give them your activation number and the System 

ID number displayed on the screen. 
4. A license file will be sent to you  

(if you have access to an email account your 
license file can be sent to you electronically.  If 
not, your file will be sent to you through regular 
mail). 

5. Copy the license file to your disk drive and 
perform the steps in the next table below. 
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If you received a license file (.lic) or ever need to restore your licenses from a backup 
.lic file: 

6. Save the license file on your hard drive in a location you can access. 
7. Reopen the license manager by choosing the File menu, click License 

Management 
8. Click Install License File. 
9. Click Browse, navigate to the location where you saved the license file, click 

the file name, and click Open. 
10. Click Install License File. 

You have completed the licensing process. 
 
Once you have licensed StageIT, licenses will be listed on the General tab of the main 
License Management page. 

 

 
 

Note: After installing the licenses, close StageIT Instructor and then re-open the 
application. This step is necessary for the licenses to become functional. 
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StageIT Instructor User Interface 
 
The StageIT Instructor user interface consists of: 
 

 Windows 
 Menu 
 Toolbar 

Floating, Docked, and Stacked Windows 
 
All tool windows can be floating, docked on any side of the screen, or stacked.  

Floating Windows  
 

  

round 
 the 

his 

Floating windows can be moved a
the screen by clicking and dragging
window bar. This mode is useful if the 
system has multiple displays. In t
image you can see the Organizer 
window being dragged off the 
application window. 
 
 
 
 
 

 
You can also click the window bar of a 
floating window and begin dragging it 
to reveal some helpful docking tools. 
While dragging the window, you can 
release the left mouse button over the 
respective docking tool to have the 
window docked to the respective area.  
In this example you can see the top, 
bottom and left docking available. The 
right side of the window is already 
occupied by the other tool windows. 
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A floating window can also be docked 
within a stacked tools area. Again, you 
simply click on the window bar and 
drag it to appropriate docking tool 
within the stacked tools area. 
 
Releasing the window in the center 
square of the docking tool would make 
the floating window become one of the 
stacked tool tabs. 
 
 

Docked windows  

  

Docked windows are attached to the application window and 
have a pin icon ( ) in the window bar.  

 

 

You can minimize a docked window by 
clicking on the pin ( ). When a window is 
minimized, it slides to the side of the 
application window. This can be a handy 
way of creating more room to work on a stage.  

 

 

 

To show it again, hover your mouse over the visible portion of 
the minimized window. Click the pin again to dock the 
window so it remains visible when your cursor leaves it. .  
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Stacked windows  
 
Stacked windows overlap and each is visible with a tab. Click the tab to display the 
window. Double-clicking a tab on a stacked window makes it a floating window. 
Double-click the window bar on a floating window makes it stacked again. 
 
The entire stacked-tools window area 
can also be floated by clicking and 
dragging the window bar. It can be left 
floating or docked elsewhere. 
 
As with individual tool windows, the 
entire stacked-tools window can be 
minimized by clicking the pin ( ) 
when it’s docked. 
 
 
 
 
 
 

Note: When you open the application, the tool windows appear as they were 
when you last closed the application.  

 

 

StageIT Instructor Menu Functions 
The StageIT menu contains all of the functions needed to work with new and 
unpublished simulations, and to publish and present a completed simulation. Most 
items in the menu have a corresponding icon in the toolbar. You can use either the 
menu or the toolbar icons to complete those functions. 
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File Menu 

 

 New - Use to create a new simulation in the authoring window. If you have a 
simulation open and it has been modified, you will be prompted to save it. 

 Open - Use to open an existing simulation. If you have a simulation open and it 
has been modified, you will be prompted to save it.  

 Save - Use to save a modified simulation. This function is disabled if the open 
simulation has not been modified. If the simulation has not been named and saved 
before, a Save As dialog box displays, prompting you to name and save the 
simulation.  

 Save As - This function displays the Save As dialog box, allowing you to name, or 
rename and save your simulation. 

 Recent - Use to display a list of recently opened simulations. Click on a simulation 
in the list to open it. 

 Present Simulation - Use this to open the Open Published Simulation window 
and choose a published simulation to present. This function hides the authoring 
window until the presentation window is closed. 
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 Publish - Use to publish the currently open simulation. If the open simulation has 
been modified, you are prompted to save it. See page 41 Publish a simulation for 
more information.  

Note:  Published sizes have a 4 x 3 aspect ratio. Because of this, using source 
material in a 4 x 3 aspect ratio will produce the best visual results. For 
example, 800 x 600 pixel size images will look the best. Larger images 
will work, but will slow down the application. 

 Open Demo - Use to open the StageIT demo shipped with the system.  

 Open Published Demo - Use to present the published StageIT demo shipped with 
the system. 

 Print Organizer - It can be helpful to view a printed copy of the simulation tree 
when you are presenting a simulation, rather than viewing it using the on-screen 
Organizer tool. 

 Print - Use to open your print dialog box for printing the structure of your stages 
in your organizer window. 

 Preview - Use to preview the simulation tree before printing it. 

 License Management - Use to license the software or see what licenses are 
available or in use. 

 Exit - Use to exit StageIT Instructor. 

Edit Menu 

 

 Cut - Use to cut and copy to the clipboard, a selected folder, stage or clip in the 
open simulation . 

 Copy - Use to copy a selected folder, stage, or clip in the open simulation to the 
clipboard. 
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 Paste - Use to paste a cut or copied folder, stage, or clip in the open simulation. 

 Options - Use to display the Options dialog box. The Options dialog box 
contains three groups of options:  General, Network, and Markup. General 
options are displayed by default. You can choose Network or Markup options by 
clicking on the icons in the left panel of the dialog box. 

Options – General 
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Note:   To get to the ‘General’ area of the ‘Options’ window you need 
to be in StageIT Instructor. Select the menu item ‘Edit’ – ‘Options’. 

 

 Load last simulation on start - Check this box to automatically load the 
last simulation that was being authored when the application starts. 

 Confirm Delete - Check this box to receive a confirming prompt every 
time a folder, stage, or clip is deleted. This option works in conjunction 
with the Don’t ask me this again check box in the delete confirmation 
window. 

 Log all status messages to event log - Check this box to log all status 
messages to an event log. There can be a number of status messages 
displayed in the status line at the bottom of the windows in StageIT, some 
of which may be error messages. This log of status messages can be a 
useful tool if the system needs debugging. 

 Video Screen Rendering - Use this option to indicate whether video cards 
used for the simulation support DirectX 9 advanced video functionality.  

If you are not sure if a video card supports DirectX 9, run the Microsoft 
application “dxdiag” on the PC in question by clicking on Start, then Run 
and typing in dxdiag, then click OK.  This application performs a series of 
tests on the system to determine whether there are compatibility problems.  

For further information, see 
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q190900

 Basic - Click this radio button if video cards in use do not support 
DirectX 9 advanced video functionality. Switch to this option if your 
computer has problems rendering the video simulation. 

Iluminar Technologies, Inc. StageIT 26  

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q190900


StageIT Instructor 

 Advanced (VMR9) - Click this radio button if video cards support 
DirectX 9 advanced video functionality. 

 Auto Play Sound Preview - Check this box to automatically play sound 
when hovering over a sound effect in the Media Library. 

Note:  You may want to turn this off when building a simulation, as it 
will play the sound when dragging effects to the simulation. 

 Configuration Settings - There may be times when you want to change 
the default location for configuration files. Use this area to specify a 
location other than the default location for configuration files. You can use 
the browse button to choose a location, or you can type a location in the 
field. Configuration files that are stored are as follows:   

 A file that keeps track of which windows are open and closed and their 
positions 

 A file that keeps track of the application properties 

 Files that are used for quick access to the graphics. These files are built 
the first time the application is run. 

 Display Elapsed Time for Students – Use this setting to determine the 
characteristics of the clock on the student computers. 

 OK - Click to close the Options dialog box and save any changes. 

 Cancel - Click to close the Options dialog box without saving any 
changes. 
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Options – Network 

 
 

Note:   To get to the ‘Network’ area of the ‘Options’ window you need 
to be in StageIT Instructor. Select the menu item ‘Edit’ – ‘Options’. 

 

 

 License Server Name - Type the name of the license server or click the 

browse button  to find a license server.  
 

Note: Clicking the browse button to find a license server may take 
some time because it searches your entire network for a server that 
supports license management. 
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The license server will be contacted to retrieve a floating license for the 
instructor and for any student applications that may connect to the 
instructor.  

 Default Port Number - When an instructor presents a simulation to 
students over a network, the instructor’s machine becomes the simulation 
network server. The only configuration detail needed is the correct port 
number, which must be entered here. Note that the instructor may have 
changed the port number since the last session. Those using firewalls 
should consult their system administrator to determine the correct port 
number to use.  

 OK - Click to close the Options dialog box and save any changes. 
 Cancel - Click to close the Options dialog box without saving any 

changes. 
 
Options – Markup 
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Note:   To get to the ‘Markup’ area of the ‘Options’ window you need 
to be in StageIT Instructor. Select the menu item ‘Edit’ – ‘Options’. 

 

When presenting a simulation, the instructor can add markup (for example, lines, 
arrows, or circles) to the presentation, highlighting something of importance. 
These options set the defaults for that markup. 

 Default Markup Color - Click Select to display the Color window. In the 
Color window, choose your default markup color from the Basic colors, or 
click Define Custom Colors.   

 Default Line Width  - Use the up and down arrows to choose your default 
line width to use while authoring simulations. 

 OK - Click to close the Options dialog box and save any changes. 

 Cancel - Click to close the Options dialog box without saving any 
changes. 

View Menu 

 

Use the view menu to display or hide the status bar, File, Video Preview, and Tools 
toolbars. A checkmark indicates the toolbar is displayed. 

 Status Bar - Use to display or hide status messages at the bottom of the screen. 
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 Toolbars 

 File - Use to display or hide icons at the top of the screen corresponding to the 
File menu. 

 Video Preview  - Use to display or hide video preview icons at the top of the 
screen. These icons are disabled until a stage is being edited. The icons are: 

 Preview Video ( ) - Click this button to pre-render the stage and 
play the pre-rendered file. A progress message displays in the progress 
bar at the bottom of the screen. When the file is playing, the play button 
converts to a stop button. If the stage does not change between plays, it 
will automatically play without the need for the pre-render. 

 Loop ( ) - Click this button to automatically repeat the play when 
the rendered file reaches the end.  

 Zoom Percentage (  )  - Use this to change the visual scale of the 
simulation being edited and the play size. All objects in the simulation 
will be re-scaled.  

Note:   Increasing the zoom percentage can increase the pre-
rendering time. If the pre-rendering fails, the scale may be too 
large. In this case, reduce the zoom percentage.  

 Tools - Use to display or hide icons at the top of the screen corresponding to 
the Tools menu. See page 31 Tools Menu.  

Tools Menu 
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Use to display or hide tools windows.  

 Find - It may become difficult to find media when there is a large collection of 
data. Use the Find tool to find media based on name or name and description. 
Description is a property of folders, stages and clips and is not used for any other 
purpose.  

 Organizer - The Organizer window provides a tree view of the simulation. The 
tree will show folders, stages, and clips. You can reorganize the tree using drag-
and-drop. 

 Organizer toolbar - The toolbar at the top of the Organizer window shows one 
set of functions when the application is in the authoring mode, and another set of 
functions when the application is in the Presentation mode.  

 Add ( ) - Click on the down arrow next to this icon to choose folder, 
stage, or clip, or click on the icon itself to automatically add a stage.  

 Edit the Selected Item ( ) - Use this icon to load a stage for editing. The 
stage name must be selected to enable this icon. Double-clicking on the 
stage icon will do the same thing. 

 Sizing icons ( )  - Click on any of these icons to resize all icons 
in your Organizer window. 

 Right-click menu - Right-click anywhere in the Organizer window to display 
a context menu. Items in the context menu will be enabled or disabled according to 
what is selected in the window. The menu selections are New, Edit, Rename, 
Cut, Copy, Paste, Duplicate, Delete, and Properties.  

• Media Library - The Media Library window displays and provides a shortcut to 
all media shipped with StageIT or imported by the user.  

 StageIT Collections - The first top-level folder in the Media Library is StageIT 
Collections, which contains media supplied with StageIT, including video effects, 
sound effects, and graphics. Some of these graphics are designed for schematic 
use, and some are designed for building more realistic simulations. The items in 
StageIT Collections cannot be rearranged, added to, removed, or renamed. 
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Note:   Add-in Media Library products such as ‘Advanced Smoke & 
Back Draft’ will also be installed to the StageIT Collections area. 

 User Collections - The User Collections folder holds any media you import. 
Media in User Collections can be renamed, rearranged, and deleted.  

 Preview Panel - The preview panel displays a representation of media in the 
library. To display a media in the preview panel, click on the media in the library, 
or move your mouse over the media. Sounds are represented with an audio 
frequency waveform. 

 Context Menu - When you right-click anywhere in the Media Library, a context 
menu is shown. Options are:   

 New Folder - Use to create a new folder in User Collections. It is disabled 
when items within StageIT Collections are selected. 

 Import - Use to import video, sound or image files into User Collections. 
If you choose to import Files from Folders, all the media in the selected 
folder tree on your hard drive will be imported into the Media Library. It 
may take time to complete if there are a large number of files to be 
imported. However, once media is organized on your hard drive, this 
organization can easily be replicated in the Media Library.  

 Rename - Use to rename folders in the User Collections. 

 Cut - Use to cut a folder or media from the User Collections. 

 Copy - Use to copy a folder or media from the User Collections. This 
option is also available when StageIT Collections is selected. 

 Paste - Use to paste a folder or media into the User Collections. 

 Delete - Use to delete a folder or media from the User Collections. 

 Properties window - The Properties window displays properties for a particular 
object. A description of each property displays at the bottom of the window. 
Properties can be expanded or sorted using the toolbar. 
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Some properties can be changed using the authoring window; for example, a clip 
can be dragged and dropped, which will change the location property. Other 
properties can only be changed using the Properties window; for example, the 
rotation property values must be entered in the Properties window. 

Note:   Properties can only be changed for items in the Organizer window, not 
in the Media Library. Undo is not supported for modifications to properties.  

 Instructor Notes - Instructor notes are entered into the Instructor window. 
Instructor notes can be attached to folders and stages, and can be useful as teaching 
aids when the instructor is navigating through the system.  

Many of today’s graphics cards and laptops allow the use of a second monitor or 
projector. The Instructors can set up the graphics card to have the same view on 
both screens or one screen-view can span across both screens (half the screen-view 
on each screen or projector). 

If the instructor is presenting the simulation using a projector, the notes can be un-
docked and floated to the Instructors local screen so they aren’t visible to the 
audience who sees the projector (see page 20 Floating, Docked, and Stacked 
Windows). 

 Student Notes - Instructors can also prepare student notes. Student notes can be 
useful if the student needs to know something about the simulation; for example, 
the student may need to know more about the type of equipment they will have 
available, wind or weather conditions, response times for apparatus or personnel. 
Students can read them as they are presented with a stage. 
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Window Menu 

 

Displays a list of all open authoring windows. You can switch between authoring 
windows by clicking on an item in the list you want to display. 

 Close All Documents - Close all open authoring windows. 

Help Menu 

 

 Contents - Use to open the StageIT Help file. 

 About - Use to display version and build information for StageIT. 

Other parts of the screen 

 

 Status Bar - The status bar is located at the bottom of the window and displays 
informational and error messages. The right side of the status bar displays progress 
bars to show the pre-rendering state or the playback state of the media. 
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Chapter 4 - Simulations
 
A simulation will generally consist of a series of stages that show the progression of a 
fire or emergency. When training emergency response personnel each stage represents 
a different phase or view of the incident, focusing on a specific subject for training. 

apter 

4 
 
The following tasks are involved in creating a simulation: 

1. Import pictures or other effects into the Media Library (if you will be using 
your own pictures, videos or audio files). 

2. Create a folder, or folders to organize your stages. 
3. Create one or more stages. 
4. Edit each stage, by adding effects from the Media Library and setting the 

properties.  
5. Add instructor notes (if required). 
6. Add student notes (if required). 

Once a simulation is created, you must publish it before you can present it to students. 
 

Create a Simulation 
 
Each time you open StageIT Instructor or when you go to File and New, a new folder 
and new stage are created and the Organizer window opens in Edit mode, ready to 
create a new simulation. More folders or stages can be added within the folder and 
media can be added by editing the stage. 
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Creating a folder 
A folder may contain one or more stages of a simulation and/or other folders.  

To create a folder: 
1. On the Tools menu, click Organizer.  
2. On the Organizer toolbar, click and hold 

the drop-down arrow next to the New 
Item icon and select Folder. 

3. Right click the New Folder and select 
Rename. 

4. Type a name for the folder. 
 

Note: You can move the newly created folder around in the Organization tree 
by dragging and dropping it. 

 

Creating a stage 
A stage represents a phase of an incident, focusing on a particular subject for training. 
For example, you can create stages showing the different views of a building, different 
time frames or outcome points of a simulated incident. 

To create a stage: 
1. On the Tools menu, click Organizer.  
2. On the Organizer toolbar, click and hold 

the drop-down arrow next to the New 
Item icon and select Stage.  

3. Right click New Stage and select 
Rename. 

4. Type a name for the stage. 
 

Note: You can move the newly created stage around in the Organization tree 
by dragging and dropping it. 
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Editing a Stage 
Media is added to a stage from the Media Library to create a realistic representation of 
a phase or view of an incident.  
 
To load a stage for editing: 

1. In the Organizer window, select the stage name to be edited, and click Modify 

the selected item ( ) on the toolbar. This will load the stage into the editing 
window. Double-clicking on the stage icon will also load the stage into the 
editing window. A set of tabs will be displayed above the editing window of all 
of the stages open for editing and video preview. 

2. When you see “Select an image from the media library” you are ready to place 
your base layer photo or video.  This base layer determines the overall duration 
of the stage.  The default duration for photos is set to 10 seconds but can be 
changed by editing the properties. (see page 65 Properties/Duration) 

3. Click the Media Library tab. 
4. From the Media Library select a Photo or Video for the base layer and drag it 

onto the editing window area. 
5. From the StageIT Collections or User Collections, open the appropriate 

folder, (ie Visual Effects then Fire) select an item, and drag it to the stage 
window. 

6. Use the ( ) Preview Video button to preview the simulation stage. 
7. Continue adding additional effects to the stage until the stage is complete. 
8. Continue editing stages until the entire simulation is created. 
 

Note:  To keep the Preview Video time short, you can reduce the image size 
by changing the zoom percentage from 100 to something smaller (such 
as 50) while previewing to make it run faster. 
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Editing media 
Media can be moved and resized to create the stage. 

To move media: 

1. Click the media so that a grid covers the item and the cursor becomes a four-
headed arrow when hovering over it. 

 

2. Hold down the left mouse button, drag the media to the proper location on the 
stage, and release the left mouse button. 

Note:  You can also use the Properties window to locate an item in the 
simulation. 
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To resize media: 

1. Click the media so that a grid covers the item. 

2. Move the mouse to the edge or corner of the media until a two-headed arrow 
appears. 

 

3. Left click, hold and move the mouse until the media is the desired size and 
then release the mouse. 

Note:  You can also use the Properties window to resize an item in the 
simulation. 

Publish a simulation 
Once a simulation is created, the simulation must be published before it can be 
presented to students. Publishing means taking all the media and related files that 
make up the simulation and bringing them together in one place along with creating 
the files that allow you to present the simulation. Simulations are published to a 
location on the computers hard drive.  

In a networked situation it is common to publish simulations to a server rather than the 
local computer. 

 

To publish a simulation: 

1. From the File menu, click Publish.... 
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2. When prompted, save the simulation. 

Note:  When publishing simulations, it is recommended that you save 
each one in a unique folder. This makes it easier to organize and 
locate published .wmv files for a particular simulation that you 
may want to incorporate into a PowerPoint presentation or other 
teaching tools. 

3. On the Publish window, select the Published Video Size and the Quality for 
the simulation. 

4. Click Publish. 

The process could take some time to complete depending on the processing 
speed of your computer. 

Note:  When publishing, you are given a series of size and quality 
choices. All the sizes are in a 4x3 ratio. This is a Windows 
media file requirement. In general, the larger the size and the 
higher the quality, the larger the output size will be.

Settings Audio Video 

Low 8KHZ 500 Kilobits / second 

Medium 16KHZ 1.5 Megabits / second 

High 44.1KHZ (CD Quality) 3 Megabits / second 

 

Revising Published Simulations: 
 
When a simulation is published a new set of files are created and saved separately 
from the authoring files. Stages are saved as .wmv files and used for presenting the 
simulation. Publishing does not delete or “lock down” your authoring files for that 
simulation – they remain available for future editing.  
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This allows a great deal of flexibility in working with simulations. If, after publishing, 
you find you want to add to, change or otherwise edit the simulation – you can. Open 
the authoring file, make the needed changes and publish again as a different version of 
the simulation. 
 
A basic simulation can be added to over time to become more complex and involved.  
You can even copy completed stages from one simulation to be used in another. 
 
Locating Published WMV Files 
 
Navigate to the location where you saved your published simulation. In that folder you 
will see .wmv files similar to those illustrated below. 

 

 

 

 

 

 
 

Present a Simulation 
Once a simulation is published, it can be presented (played) in two ways: 

 On a single computer 

 Over a network 

Presentation Window 

The Presentation window displays simulations to students. When the presentation 
window is shown, the authoring window is hidden. 
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The tools available in this view are the Organizer, the Student Notes, the Instructor 
Notes, and the Elapsed Timer. 

Presenting a simulation locally 

Simulations are presented one stage at a time. Stages can be presented sequentially, 
showing the progression of an incident. Or, an experienced presenter can produce 
simulations with a variety of outcomes and navigate between stages based on student 
reactions to what they see on screen. 

To present a simulation: 

 In Manual Play Mode 

1. On the File menu, click Present Simulation. 

2. Navigate to the location of your saved simulations, and select the simulation to 
present. 

Note: Simulation files have a .sim extension. 

3. To begin playing the simulation in Manual mode, click Play/Pause ( ) or 
double-click the icon or name in the organizer window for a particular stage. 

4. To pause the simulation, click Play/Pause ( ). 

5. To stop the simulation, click Stop ( ). 

 In Auto Play Mode 

 To Play the simulation in Auto mode click on the 
down arrow next to the Play menu item at the top 
of the organizer and select Auto.  Now when you 
click Play/Pause ( ) it will play the stages in 
order and automatically advance to the next stage.  
The duration that was originally set for each stage 
during authoring will determine the play time. 

 Both the Manual and Auto play methods work in Local Presentation and 
Networked Presentation. 
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Marking up a simulation 

When playing a simulation, instructors can add markup to the presentation, calling 
attention to certain aspects of the simulation. Markup can be in the form of lines or 
free-hand drawings.  

 

Note: Markups will only display on the instructors computer. In addition, 
Markup is only available in local mode. It is not available in Fill or Maximize 
mode.  
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To markup a simulation: 

1. On the Presentation toolbar, click Select markup color, pick a color to use 
and click OK to set the color for the markup line. 

2. On the Presentation toolbar, click the arrow next to Select line width, select 
the desired line width, and click OK to set the width of the line. 

3. On the Presentation toolbar, click the arrow next to Style, and select Free 
Hand or Lines to set the type of markup. 

4. To begin markup, click the mouse, move it over the presentation, and then 
release the mouse. The stage must be playing for the markup lines to be visible 
initially or to be cleared. 

5. To remove the markup, on the Presentation toolbar, click Clear the markup 
( ) or, Right-Click anywhere on the screen and choose Clear the markup 
from the drop-down menu. 

 

Presenting a simulation over a network 

If students are at other locations, or other computers in a classroom setting, 
simulations can be presented over a network. 

There are a number of steps required to present over a network: 

 Start the server. 

 Add or remove groups 

 Students must connect to the server. See page 53 Starting StageIT Student for 
more information. 

 Add students to a group 

 Add a stage to a group. 

 Play the stage. 
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To present the simulation: 

  

ill 

1. In the Presentation window, on the 
File menu, click Start Server.  The 
Start Network Server window w
display. 

Note the Server Hostname because 
students will need this name to 
connect.  

 

2. The window opens with the first group displayed as Group Name. The field is 
automatically highlighted so you can begin typing and editing the group name to 
something more meaningful. 

Note: More groups can be added once the server is started. 

3. Click the Start button to start the server service. 

4. You can now click the Add Group button  to add more groups to 
the presentation.  

Note: Each group can hold a 
different stage and any number of 
students. Stages and students can be 
added or removed from groups. 
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5. Students should log on and connect to the server 
(see page 53 Starting StageIT Student).  

Once they do the Remote Students window looks 
like this: 

 

6. Click on a student’s name and drag the name into the Students window in one of 
the group sections. 

7. From the Organizer tab, drag a stage into one of the group sections. 

8. Click Play. 

Note:  To control all groups simultaneously, use the video controls in Global 
Control. To control each group separately, use the video controls in the 
individual group section. 

 

9. To play the next stage, click Next. To play any stage out of order simply select the 
stage and drag and drop it to the desired group window and click Play. 
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10. To play the same video continuously, check Loop. 

11. If you uncheck the Pause On Load box, stages will play immediately when 
dragged and dropped into a group window. 

Note:  When playing multiple presentations, depending on the speed of your 
computer, there may be some degradation in the video or audio 
playback on the instructor computer. 

 

Media Library 

 

The Media Library consists of pictures, sounds and visual effects supplied with the 
system (StageIT Collections) and custom pictures and effects that you import (User 
Collections). 
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StageIT Collections 

A collection of pictures, sounds and visual effects are 
supplied with StageIT. They are divided into the 
following sections: 

 Images – pictures of miscellaneous items such as 
hydrants, ladders, signs, vehicles 

 Visual Effects – fire, hazmat, smoke, and smoke 
damage  

 Sound Effects – explosions, fire, sirens, radio 
communications 

 Photos – pictures of various types of buildings 

To see the images and photos supplied in the StageIT 
collections, click the Media Library tab in the right-
hand window. Expand each category by clicking the 
plus sign next to the category (Images, Visual Effects, 
Sound Effects, and Photos) and then continue 
expanding until you find the correct effect. 

A preview of the image or effect can be seen in the 
bottom pane of the window. 
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User Collections 

You can add your own photos and effects into the 
Media Library. Any digital picture, video or digitized 
sound effect can be imported into the User 
Collections. 

Importing Media 

To import media: 

1. On the Media Library toolbar, click the arrow 

next to the Import icon ( ) and select the 
type of media to import. 

2. Navigate to the location of the file, select it, 
and click Open. 

You can import pictures of any size into 
StageIT, but for ease of use in sizing 
animations, speeding up rendering of a 
simulation, and matching with video clips, we 
recommend that imported pictures be 800 x 
600. 

3. If you want to import more than a single file, StageIT provides an import “files 
from folders” function that imports all the useable information (videos, 
graphics and sounds) into the user collection while maintaining and 
representing the imported files within the original folder structure found in the 
Windows file system. 

4. To import an entire file folder, on the Media Library toolbar, click the arrow 
next to the Import icon and select Files From Folders from the drop down 
list. Navigate to the folder and select it. The imported file or folder will appear 
in the User Collections. 

5. You can also import into User Collections area by right-clicking on a folder 
and selecting the type of media to import. 

  

Iluminar Technologies, Inc. StageIT 51  



Simulations 

 
This page intentionally left blank 

Iluminar Technologies, Inc. StageIT 52  



 

 
Chapter 

  

 

Chapter 5 – StageIT Student  
StageIT Student works in conjunction with StageIT Instructor. In StageIT Student, 
students view a simulation played from the Simulation Network Server. In addition to 
viewing the simulation, students can increase or reduce the size of the media they’re 
viewing, type notes in the chat window that will be seen by all other students and the 
instructor, and view any student notes the simulation author may have included in the 
published simulation. 

5 
Starting StageIT Student 
When you start StageIT Student, you will be prompted to connect to the Simulation 
Network Server, which enables you to access a simulation from the server.  

Note:  Before a student can view a simulation in StageIT Student, the 
instructor must set up and play the simulation. (See page  43 Presenting a 
simulation ) 

To start StageIT Student: 
 
1. Double-click the StageIT Student icon. The 

Connect dialog box appears. 
2. In the Your Name field, type your name. 
3. In the Server Name field, type the server name. If 

you don’t know the server name, contact your 
instructor (this will be the name of the instructor’s 
computer). 
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4. Click Connect. 
Unless a default file location has been set in Options, the first time the student 
connects, the student will need to define a location for storing simulation files. 
The StageIT Student window appears, and if the instructor has started the 
simulation, it will play in the main window. 
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StageIT Student Menu and Toolbars 
 
Most items in the View and Video Size menus have a corresponding icon in the task 
bar. You can use either the menu or the task bar icons to complete these functions. 

File Menu 

 

 Connect to Server - This displays the Connect dialog box. This function is 
disabled if the student is already connected. 

 Exit - This exits the StageIT Student application. 

View Menu 

 

 Toolbars - This allows you to view or hide toolbars and windows in the StageIT 
Student application. If the checkbox next to the menu item is disabled (grayed out) 
then the item is not currently displayed in the toolbar or window. Click to display 
or hide each item. 

 Tools - This hides or displays the Tools toolbar, which includes Chat, Student 
Notes, and Elapsed Time. 
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 Video Size - This hides or displays the video size buttons, which includes 
50%, 75%, 100%, 200%, Maximize, and Fill. 

 Chat - Hides or displays the Chat window. 

 Notes - Hides or displays the Student Notes window. 

 Elapsed Time - Hides or displays the Elapsed Time. 

 Options - Displays the Options dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

 Default Server Name - A default server name can be entered in this field. If 
the server name is entered here, it appears automatically in the Connect dialog 
box when StageIT Student is started. 
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 Default Port Number - When an instructor presents a simulation to students 
over a network, the instructor’s machine becomes the simulation network 
server. If you enter a port number here, it will appear automatically in the 
Connect window.    

 Download Folder - Enter a default location for storing downloaded 
simulations. If you don’t enter anything here, you will be prompted to enter a 
location when a simulation begins downloading.  

 Folder for Configuration Files - There may be times when you want to 
change the default location for configuration files. Use this field to specify a 
location other than the default location for configuration files. You can use the 
browse button to choose a location, or you can type a location in the field. 
Configuration files that are stored are as follows:   

 A file that keeps track of which windows are open and closed and their 
positions 

 A file that keeps track of the application properties 

 Log All Status Messages to Event Logger - Check this box to log all status 
messages to an event log. There can be a number of status messages displayed in 
the status bar at the bottom of the screen, some of which may be error messages. 
This log of status messages can be a useful tool if the system needs debugging.  

 Video Screen Rendering - Use this option to choose whether video cards used 
for the simulation support DirectX 9 advanced video functionality.  

If you are not sure if a video card supports Direct X 9, run the Microsoft 
application “dxdiag” on the PC in question. This application performs a 
series of tests on the system to determine whether there are compatibility 
problems. For further information, see 
http://support.microsoft.com/default.aspx?scid=kb;en-us;Q190900

 Basic - Click this radio button if video cards in use do not support 
DirectX 9 advanced video functionality. 

 Advanced (VMR9) - Click this radio button if video cards support 
DirectX 9 advanced video functionality. 
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 OK - Click to close the Options dialog box and save any changes. 

 Cancel - Click to close the Options dialog box without saving any changes. 

Video Size Menu 

 

 Sizes - These percentage options reduce or enlarge the size of the simulation video 
that plays in the main window.  

 Maximize - Choosing Maximize enlarges the video size proportionally to be as 
large as possible in the StageIT Student window, while maintaining the aspect 
ratio. 

 Fill - Choosing Fill enlarges the video size so that it fills the main window. The 
video may be distorted if the video proportions are not the same as the StageIT 
Student window proportions. 

Help Menu 

 

  
 Contents - This displays the contents of the StageIT Student online help file. 
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 About - This displays a dialog box with information about the application. 

 

Toolbars 

 

 Size (50%, 75%, 100%, 200%, Maximize, Fill) toolbar - The size toolbar 
corresponds to the Video Size menu options. You can use these buttons for quick 
access to resizing options for the simulation video. 

 Chat, Student Notes and Elapsed Time toolbar - These options correspond with 
options in the View menu. You can use these buttons to hide or display windows. 

 Add or Remove Buttons menu - Clicking the down arrow next to either toolbar 
displays a menu with options to add or remove any of the buttons from the toolbar. 

 

Window Management  
Both the Chat and Student Notes windows can be floating, docked on any side of the 
screen, or stacked. For more information, see page 20 Floating, Docked, and Stacked 
Windows

Status Bar 
The status bar is located at the bottom of the window and displays informational and 
error messages. The right side of the status bar displays progress bars to show the play 
progress.  
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StageIT Student Window 
A student can do three main functions in the student window. A student can: 

 Reduce and enlarge the size of the simulation media 

 Chat with other students and the instructor 

 View student notes 

Reduce and Enlarge Simulation 

A simulation plays in the student window at a default size. The student can reduce or 
enlarge this size using the View menu or the corresponding tool bar icons. 

To reduce or enlarge the size of a simulation: 

 From the StageIT Student window with the simulation playing, click one of the 
percentage buttons, or click Maximize or Fill. 

The simulation is resized according to the measurement you chose. 

Chat 

When a simulation is playing, there may be scenarios where it would be helpful for a 
student to communicate with other students and/or the instructor. 

Note:  Text that is typed into the Chat window is viewable by all other 
students and the instructor. 

To chat: 

1. From the StageIT Student window, click the Chat tab at the bottom right of the 
screen. 

Note:   If the Chat tab is not available, on the View menu, click Chat to 
display the Chat window. 
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2. Type a note into the text box at the bottom of 
the Chat window.  

If the note is longer than the box, the scroll 
bars will be enabled to allow you to scroll 
through what you just typed. 

3. Click Send. 

Your note appears in the Chat window. 

 

 
Student Notes 

Student notes are set up when an instructor builds a simulation. An instructor can add 
notes for the student to read while the simulation is playing. The instructor can add 
different notes for each stage of the simulation. These notes can be helpful to further 
explain or clarify the simulation noting things such as weather conditions or response 
times for apparatus etc.  

 

To view student notes during a presentation of a simulation: 

 From the StageIT Student window, click on the Student Notes tab at the bottom 
right of the screen. 

Note:   If the Student Notes tab is not available, on the View menu, click 
Student Notes to display the Student Notes window. 

The Student Notes window displays with any notes pertaining to the stage in 
view. 
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Chapter 

6 Chapter 6 – StageIT Advanced 
Features 

Editing Clip Properties 
 
One of the most powerful tools in StageIT is the ability to edit clip properties. Using 
the Properties window, attributes can be adjusted for any clip or object placed in a 
stage, allowing for the creation of very realistic effects in a simulation. You can make 
objects fade in or out, adjust transparency levels, change sound levels, delay when 
objects will appear in your simulation, change the speed at which clips play and resize 
or relocate objects. Properties that cannot be adjusted for a particular object will be 
dimmed in the Properties window or will not be available on the list. 
 
Once you become familiar with managing properties you will find that you have 
nearly limitless control of the objects in your Media Library. Some of the properties 
that you can adjust to modify the simulation are: 
 
 Size – varies the size of the media. You can also 

do this in the Stage Editing Window (see page 40 
Editing Media) 

 Flip – Flip image horizontally and/or vertically 
 Rotate – degrees of clockwise rotation of image 
 Speed – varies how fast the clip runs 
 Duration – varies how long the clip lasts 
 Fade – allows the clip to appear or disappear 

gradually 
 Start delay – delays the start of a clip after the 

start of the stage 
 Transparency – varies how see-through the clip is 
 Visibility – controls whether you can see the clip 

 
Iluminar Technologies, Inc. StageIT 63  



 

Properties Window 
To display the properties pertaining to a particular object in your stage, select the item 
by clicking its icon in the Organizer (A), or clicking directly on the item in the Stage 
Edit window (B). In the Properties window (C), you can confirm that you have the 
correct item selected by looking at the Name field. This should correspond to the 
name that is listed in the Organizer (A). 

 

 

After making adjustments to the properties of an object, you can see how the changes 
affect the object by clicking Preview Video ( ) on the toolbar. This will render and 
play the stage so you can check to see if you have the effect you want. If not, readjust 
the settings in the Properties window and click Preview Video again. Repeat this 
process until you have the exact effect you want. 
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Another way to access the Properties window, if it is not already visible, is to right-
click the object in the Stage window and click Properties from the drop-down menu. 

 

 

Duration 

 

 
Sets the length, or duration, of the clip in seconds. In other words, this indicates how 
many seconds the clip will play. Insert Type (see page 68 Insert Type below) allows 
you to choose whether a clip will play one time in the stage (Once), or will loop and 
continue to play for the full duration of the stage (Fill). 
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The length of the base photo or base video determines the overall duration of a stage 
in your simulation. The default duration for a photo is 10 seconds. You can adjust the 
duration of a photo in the Properties window by typing in a new number in the 
duration field. After typing in a new number, press Enter on your keyboard or click in 
another field in the Properties window to make sure the change takes effect. 
 
When using video as the base clip, the length of the video segment sets the stage 
duration. You cannot change the duration of a video clip in the Properties window 
using the Duration setting. You will notice that the duration value for a video clip is 
dimmed, indicating that it cannot be changed. You can adjust this using the Mark 
In/Mark Out feature (See page 71 Mark In / Mark Out  below) 
 
For example, if the duration of a clip, such as a fire clip is 2.5 seconds, but the stage 
being built runs for 10 seconds, choosing Fill in the Insert Type field will play the 
clip 4 times to fill up the ten seconds that the stage runs. 

Fade In / Fade Out 

 
 
Fade In or Fade Out allows you to make an object gradually appear or gradually 
disappear in your stage. The settings in the Fade In or Fade Out fields are listed in 
seconds. 
 
You can use this setting to give clips such as smoke or fire a very realistic appearance. 
This lets you “grow” your fire or smoke rather than having it simply appear on the 
screen. 
 
For example if you set the Fade In setting of an object to “3”, that object will go from 
0% visibility (transparent) to 100% visibility (solid) over the course of three seconds. 
Conversely, if you if you set the Fade Out setting of an object to “3”, that object will 
go from 100% visibility (solid) to 0% visibility (transparent) over the course of three 
seconds. 
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The Fade In begins when the object or animated clip is set to start playing. An object 
with a three second Fade In would be fully visible three seconds after the object starts 
playing.  
 
The Fade Out is keyed to the end of the playing time for the object or animated clip. 
An object with a three second Fade Out starts to fade from 100% visibility (solid) to 
0% visibility (transparent), over the course of three seconds, starting from three 
seconds before the end of the object playing time. 
 

Tip:   While you cannot set an object to fade in to anything less than 100% 
transparency, you can accomplish this effect by using two copies of the 
same object. Set the first copy to Fade In and use timing in the Mark 
Out feature to make it disappear before it reaches 100% transparency. 
Set Transparency (see page  Transparency below) on the second 76
copy to the level you want and then set the Start Delay (see page  75
Start Delay below) feature in properties so that the second object 
appears at the same moment the first object disappears. 

 
You will want to line up the location of the two copies exactly on your stage for the 
effect to look right. Rather than moving the objects by clicking and dragging it is 
better to set their locations to match in the Properties window. Under Location in the 
Properties window, check the X and Y settings of the first copy and then type in the 
same setting for the second copy. This will line up your copies exactly and make your 
effect seamless. 

File Path 

 

 
This shows the path to the object or media file stored on your computer. 
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Flip 

 
 
An image or photo used in a stage can also be flipped over horizontally, vertically or 
both. The default is to not flip the image however you can by clicking the down-arrow 
beside the field name and selecting from the drop-down list. 

Insert Type 

 
Indicates whether a clip will play for the entire duration of a stage, repeating if 
necessary (Fill), or play one time during the length of that particular stage (Once). To 
change this setting, click in the Insert Type field. A drop-down arrow will appear to 
the right of the field. Click on the drop-down arrow and click either Fill or Once. 
 
An example of how you might use this would be to simulate an explosion. If you place 
a clip such as “Single explosion” from the Media Library in your stage and choose 
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Insert Type of Once, the explosion will occur in the stage one time. If you choose 
Fill as the Insert Type, it will repeat for the duration of the stage. 

Layer 
Indicates where the object is located in relation to the base layer in a stage. This is also 
indicated in the Organizer window. Layering allows you to place fire in front of 
smoke or smoke in front of fire, for example. In the Properties window, the base 
photo or base video for a particular stage will be listed as the “0” layer. The first clip 
or object placed on that base will be “1”, the next will be listed as “2”, etc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
If a fire clip is in the “1” position and a smoke clip is in the “2” position, the smoke 
will appear in front of the fire in your simulation. 

 

  

 
 

 

To change the order of the layers, go to the Organizer 
window. In the example below, the Ground fire (A) is
in layer number nine above the Wide Gray smoke (B)
that is in layer number ten. The base video layer titled
“Bryce Run Out” is layer zero. 
 
In this configuration, the Wide Gray smoke will 
appear in front of the Ground fire when the 
simulation is published.  
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In order to change the layers and have the Wide Gray 
smoke appear behind the Ground fire, click the Wide 
Gray smoke, hold down the mouse button until you 
see the cursor line appear and then drag the line until it 
appears above the Ground fire (C). Release the mouse 
button and Ground fire should now appear below the 
Wide Gray smoke on the list (D). 

 
 
 
 
 
 
 
As indicated in (D), the Wide Gray smoke is now in 
layer nine and the Ground fire is in layer ten. In this 
configuration the smoke will now be behind the fire in 
the published simulation. 

 

 
 
The Clip List Editor for the stage, found in the Properties window, is another way to 
reorder layers. For more information, see page 79  
 
Viewing Clips in a Simulation. 

Location 
Indicates the horizontal (X) and vertical (Y) location of an object in the Stage window. If 
you do not see the X and Y fields in the window, click on the plus sign next to Location. 
By changing the values in the X and Y-axis fields you can precisely change the location of 
the object in the Stage window. This is useful if you are trying to line up objects in an exact 
location or in relation to each other. 
 

Iluminar Technologies, Inc. StageIT 70  



 
A more direct way to change the location of an object is to select it by clicking it in the 
Stage window. An object is selected in the Stage window when it is surrounded by a 
black box with a gray grid pattern in it (A) and the mouse pointer turns to a four-
headed arrow. Hold down the mouse, drag it to the desired location in the window, 
and release the mouse.  

 

Mark In / Mark Out 

 

  

Adjusts which portion of a particular clip will play in your stage. As a default, for each 
clip, the Mark In time will start at “0” and the Mark Out time will be set to the 
length of that clip. In the example above, the Mark Out time is “3.0363667.” That 
means this particular clip will run for 3.0363667 seconds. 
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If this clip is placed on a stage where the base photo or base video has a duration of 10 
seconds and you set the Insert Type property (see page 68 Insert Type above) for this 
clip to Fill, the clip will loop and play over 3.29 times to fill up the time set for the 
stage. 
 
If this clip is placed on a stage where the base photo or base video has a duration of 10 
seconds and you set the Insert Type property (see page 68 Insert Type above) for this 
clip to Once, the clip will play one time for 3.0363667 seconds. After the clip plays, 
the stage will continue to run for another 6.963634 seconds. 
 
Adjusting the Mark In or Mark Out times determines the part of the clip that is 
played. (See the tip under Fade In / Fade Out for an example – see page 66). Setting 
the Mark In time on the clip in our example above to “1” and the Mark Out time to 
“2” would play the middle portion of the clip as illustrated in the figure below. 
 

  

 
 
 

 

Media Type 

 
Indicates the type of object you have in your stage - for example, video, sound, etc. 
This field cannot be edited. 
 

20 3.03636671
Original 
Mark In 

New Mark 
Out 

Original 
Mark Out 

New Mark 
In 
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Rotation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Rotation controls the degrees of clockwise rotation of an image used in the scene. 
 

Mute 

 
Controls the audio of an object. From the drop-down menu you can mute the sound 
(True) or turn the sound on (False).  
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Size 

 
Controls the width and height of an object in pixels by changing the numbers in the 
fields.  

  

A more direct way to change the size of an object is to click it in the Stage window to 
select it. An object is selected in the Stage window when it is surrounded by a black 
box with a gray grid pattern in it (A). 
 
Move the mouse over the black line of the selection box until the mouse pointer forms 
a two-headed arrow. When it does, hold down the mouse button, move the pointer 
until you achieve the size you want, and then release the mouse button.  
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Speed 

 
Adjusts the relative speed at which a video clip will play in your stage. Speed is 
inversely related to the size of the number. Decreasing the number value in this field 
speeds up the clip. Increasing the number value in this field slows down the clip. 
 
For example, if you adjust the value in the Speed field from “100” down to “50” on a 
smoke clip, the smoke will appear to move up in its column twice as fast. If you adjust 
the value in the Speed field from “100” up to “200” on a smoke clip, the smoke will 
appear to move up in its column more slowly. 
 
You can use this to give different looks to columns of smoke that you are putting 
together to build larger columns. This prevents all of the columns from looking like 
carbon copies of each other and gives you more realistic effects. 

Start Delay 
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Adjusts when the object will become visible in a stage. The delay time is listed in 
seconds. For example, changing the value from “0” to “2” means the object will 
become visible in your stage 2 seconds after the stage starts playing.  
 
This effect can be combined with the Fade In / Fade Out effect (see page 66 in the 
section above) to make the object gradually appear at the indicated delayed start time. 
If the Fade In/Fade Out effect is not used in conjunction with the Start Delay the 
object will pop on to the screen at 100% transparency at the indicated time. 

Transparency 

 
Adjusts the transparency of an object. The value represents a percentage of total 
visibility. A “0” setting makes the object invisible. A “75” setting shows the object at 
75% of total visibility. 
 
Transparency is useful in making fire or other objects blend into lower light conditions 
in a photo. The effect can also be used on base photos to darken them for interesting 
effects such as simulating low-level light conditions or nighttime on a photo that was 
actually taken during the daytime. 
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Volume 

 
Controls the sound level of the base video clip or other sound files placed in a stage. 
The value represents the volume level of the selected clip as a percentage of the sound 
level for the entire stage. 
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There are three basic ways to utilize this feature: 
 Controlling which audio clips are more distinct than others, representative of 

background noise levels compared to foreground noise levels.  
 

For example, audio clip A is a background noise such as a fire burning at the back 
of a building, while audio clip B is that of radio traffic heard on the viewer’s 
portable radio at the front of the building where the viewer is indicated to be 
standing. To make the radio traffic sound closer, set its value higher than that of 
the fire sound at the back of the house.  

 
 Leveling out the volume of all the audio clips in a stage. Volumes are additive. 

Adding several audio clips to a stage creates an additive effect on the sound and 
they may play more loudly than intended. By adjusting the values in this field the 
volume of the clips can be leveled to play at appropriate volumes. 

 
 Adjusting the volume of an imported video or audio clip whose playback volume 

turns out to be too loud or too soft. Correct by changing the value in the field up or 
down until the desired volume is reached. 

 
Note: The volume setting of a clip can be increased beyond 100, but the 

further beyond 100 the setting is increased, the greater chance that 
the sound quality of the clip will degrade. 

 

Common 
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Click the plus sign next to Common to see the fields shown above.  
 
Description – allows entry of an additional descriptive phrase for the selected object. 
Name – Default shows the name of the object as it appears in the Media Library. 
Changing the name here changes the name for this object in the Organizer for that 
stage of the simulation currently being worked on. Changing the name here will not 
change the name of the object in the Media Library. 
Type – Indicates the type of object selected. This field cannot be edited. 
Visible – Click in this field to view the drop-down menu. Picking True makes the 
object visible in the stage; False makes the object invisible in the stage. 
 

Viewing Clips in a Simulation 
 
When you select the stage level of the simulation, you can view all the clips contained 
in the collection. Then you can re-sequence the clips within the stage, add or remove 
clips, and change clip Properties. 
 
To view clips in a simulation: 

  

ou 

 
1. Select the stage name in the Organizer. 
2. On the toolbar, if Properties are not 

already displayed, click Properties. 
3. Scroll down through Properties until y

see Stage. 
4. Click the plus sign next to Stage. 
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5. Click the ellipsis next to Collection. The Clip List Editor window will open, 
showing all the clips contained in the stage in the sequence that they were created. 

 . 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. To add a clip, click Add, navigate to the location of the clip, select the clip, and 
click Open. 

7. To remove a clip, select the clip and click Remove. 

8. To change the sequence of presentation layers, select a clip and click Up ( ) or 

Down ( ). 
 
 

Iluminar Technologies, Inc. StageIT 80  



 

 Chapter 

7 Chapter 7 – Using StageIT 

Promotional Testing 
 
This section contains general guidelines for your promotional test. They are not 
intended to supplement your organization’s operating guidelines or procedures. 
 
The StageIT Emergency Response Simulator provides an effective and unbiased way 
to administer the scenario portion of promotional tests within your organization. 
 
Simulations can be presented to candidates showing each incident scenario. They can 
then respond to the situation they are viewing on the screen. Presentations can take 
place on a single computer monitor or projected to a large screen. 
 
Typically, a time limit is established for the candidates to view each scenario or stage. 
Control of the timing can be handled one of two ways: 
 
 In Presentation mode, the proctor can manually move to the next stage at the 

appropriate time. 
 Alternately, the stages you want to display can be set to advance automatically 

using the Auto play feature from the Organizer window in Presentation mode. 
(See page 44 Manual and Auto Play Mode) This can help guarantee that testing is 
identical for every candidate.  

 
Stages can be combined with a narrated script. A proctor may facilitate the test by 
narrating additional information for each stage shown such as, “Shouts are heard on 
the main floor, southwest corner.” or “The ceiling collapses now.” 
 
An even more effective method is to record these narrations and import them into your 
simulation so that they play automatically with each scenario. This eliminates the need 
for the proctor to read the narration and further ensures that the test is identical for 
each candidate. 
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Secure testing for promotional exams is important. After creating a test, you may want 
to save it to removable media or to a folder on your computer or network that only 
instructors can access. 
 

Setting up a promotional test 
 
Make sure all candidates are fully informed about the details of the testing process. It 
is a good idea to give to each candidate a written information page to guarantee each 
one is given the same instructions or set up the first stage as the Instruction page.  

1. Indicate to candidates how the test will be conducted: 
• You will view a timed simulation with scenarios for three different 

buildings. Six to ten minutes will be allowed for each scenario. 
• Your simulation will be identical to the simulation used for testing all 

other candidates. 
• Each scenario will include a distance view of the building, a printed 

plot plan, and one or more views of the building showing the progress 
of the fire. Three minutes will be allowed for the main view and one to 
two minutes for each additional view. 

• You will hear a narration about the progress of each fire; for example, 
“Now the ceiling collapses.” 

• Either an audio or video recording will be made of your responses 
during the test so they can be carefully evaluated. 

2. State what is expected of candidates during the test and what they should do 
with each scenario: 

• When the distance view of the building appears on the screen, discuss 
what actions you would take at that point, such as calling for additional 
resources or changing your approach route. 

• When the close-up view of the building appears, compare it with your 
printed plot plan handout. Indicate on the handout where you would 
position the apparatus. The plot plans will be handed in at the end of 
the test. 

• Explain your fire attack in detail. 
• If a new slide shows the fire in a different stage, adjust your tactics to 

address the new situation just as you would in the field. 
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• If the narration indicates a change, adjust your tactics as you would in 
the field. 

3. List in detail the information candidates are expected to notice and address in 
their responses: 

• Building type 
• Occupancy estimates 
• Where the fire is coming from 
• The equipment needed and in what situations each tool will be used 
• The initial fire attack, including such things as entrance into the 

building, where to turn the hose, how many fire hoses are needed etc. 
• Radio communications such as calling for additional resources, 

informing the chief of your status and completed tasks  
• All other details, such as feeling the walls and floors, checking for 

victims, yelling to see if anyone responds 

Building a Promotional Test Simulation 
To keep tests organized, it is helpful to name the simulation with the testing time and 
place - for example, “OurCity_3_10_06” 
Start with three or four different types of buildings and develop an entire scenario for 
each one. For example: 
 

1. Single-family dwelling 

2. Multi-family dwelling or apartment building 

3. Light industrial or commercial building such as a strip mall, theater, gas station 

etc. 

4. High-rise (over six stories) if they exist in your response area 

Example Stages to Include in Each Simulation 

1. Distance Views 
Show the building from about a block away. Add smoke and/or fire animations 
representing the situation so candidates can determine the information they 
will give to the dispatcher as they arrive on scene. 
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2. Front, Side, Rear or Interior Views 
Add smoke and/or fire animations representing the situation. You might also 
add symbols or HAZMAT placards to indicate hazards on commercial 
buildings. 

3. Additional views 
To show the fire growing, add other stages based on the same photograph or a 
different view of the building. For example: 

Stage 1 – add a little smoke at a door, window or roofline 
Stage 2 – increase the amount of smoke 
Stage 3 – add fire shooting out from the lowest point of the smoke. 

Creation of Plot Plan Handouts  
For each simulation, create a printed plot plan that shows the streets and alleys 
adjacent to the building. Give these documents to each candidate to mark up with the 
locations of apparatus, etc. 
 
On the plot plan indicate the following: 

• North 
• Building’s location and orientation 
• Exposures 
• Connected buildings 
• Hydrants 
• Gates and driveways providing access to the building 
• Full, proper name and / or number of the building 
• Full street address. If more than one address, include the beginning and ending 

in the series 
• Type of building and the operation such as restaurant, retail sales, office etc. 
• Normal occupancy 

• Types of buildings connected to the subject building 
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An example of timing for a promotional test: 
 

Scenario View / Stage Time (minutes)
Structure 1 Distance 1
Structure 1 Front / Stage 1 3
Structure 1 Side / Stage 1 2
Structure 1 Front / Stage 2 2
Structure 1 Side / Stage 2 2
Structure 2 Distance 1
Structure 2 Front / Stage 1 3
Structure 2 Side / Stage 1 2
Structure 2 Front / Stage 2 2
Structure 2 Side / Stage 2 2
Structure 3 Distance 1
Structure 3 Front / Stage 1 3
Structure 3 Front / Stage 2 2
Structure 3 Front / Stage 2 2
Structure 3 Side / Stage 2 2

Total Time 30  
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Pre-Incident Planning 
 
This section contains general guidelines. Use them as appropriate for your pre-incident 
planning. They are not intended to supplant your organization’s operating guidelines 
or procedures. 
 
Pre-incident planning is a vital component of an efficient and safe fire ground 
operation.  
 
Possessing pre-incident knowledge of a structure and its relative hazards is critical. 
 
Pre-incident plans typically consist of pertinent building information including: 
names, addresses, and phone numbers of the building and business owners, emergency 
contacts and phone numbers, water supply information, access and alarm system 
instructions, and fire suppression and rescue strategies. Special hazards are also noted, 
as well as the type of construction for the main "shell" and roof. 
 
In most instances, drawings are made to scale to include an overall site and building 
plan. Site plans show the entire complex, surrounding exposures, street accesses, and 
hydrant locations.  
 
Building plans usually show a comprehensive floor-by-floor diagram of interior 
partitions and fire walls as well as locations of utility shut-offs, fire suppression 
systems, fire department connections, fire alarm panels, key boxes, and roof and attic 
accesses. 
 
This information is used by firefighters and command staff to improve the 
effectiveness and safety aspects of the response and operations when on scene.  
 
Digital cameras now make it easy for photographs to be attached directly to pre-
emergency plans and, where available, displayed from on-board computers en route to 
a scene.  
 
Pre-incident plans are also utilized during non-emergency periods for training 
exercises. Firefighters can familiarize themselves with a selected complex and review 
possible scenarios and strategies to best handle potential emergencies. 
 
Combining a simulation with pre-incident plans can make for very effective pre-
emergency training. If you already have pictures attached to your pre-incident plans, 
you can use those pictures in StageIT for pre-incident training. 
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Tips for preparing a pre-incident simulation: 
 
• Create a simulation showing multiple views of a selected building in your response 

area.  
See page 83 Building a Promotional Test Simulation for tips on creating a 
simulation. 

• Create a variety of simulations for the same building will allow personnel to 
experience different incident scenarios possible for that structure. 

• Provide handouts of the pre-emergency plans that would be accessible to your 
personnel on an actual emergency response.  

• If the simulation is presented in a networked environment, assign different views 
of the building to different individuals. For example, assign one view to the 
Incident Commander, another to the interior attack crew etc. The training is most 
effective if the individual participants cannot see the screen views of the other 
participants – just as someone on the interior attack crew at an actual incident 
cannot see what the view is from the outside of the building. 

• For added realism, have all communications carried out on the tactical channel on 
your radios. 

• Designate someone as the first on scene and have them indicate their actions based 
on what they see, the handout information from the pre-emergency plans and any 
other written or audio information you have included in the simulation. 

• Change the stages (views) of each participant based on their responses, either 
escalating or containing the incident based on proper or improper actions taken. 

 

Post-Incident Critique or After-Action Review 
 
The purpose of a post-incident critique is to: 
 Establish where and how a group of fires started 
 Recognize factors that contributed to the fire 
 Determine the extent of the damage to people structures and personal property 
 Evaluate the results of the fire attack - reviewing appropriate and inappropriate 

actions 
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Simulations built from pre-fire and post-fire photos can make the analysis or critique 
of an incident much more effective. They can help personnel relive the actual incident, 
allowing you to review what was happening at the scene at the time, and propose 
alternatives to inappropriate actions taken. 

Setting up a Critique 
Prepare the following items for use in a post-incident critique: 
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Birds eye view of an incident 

Import an aerial photo or map of the incident area that shows the streets and alleys 
adjacent to the building. Google maps (http://maps.google.com/) can be a good source 
for a map or you can use an overhead plot plan of an intersection provided in the 
media library of StageIT. Add icons to the photo or map to represent:  

 Building’s location and orientation  
 Position of apparatus  
 Hydrants  
 Entrance used by firefighters 

Smoke and fire animations can be added to the overhead view to give it more impact. 

Pre-Incident Photos 
Show pictures of the building or scene prior to the fire. If none are available, try to 
find a photo of a similar building or location. 

Post-Incident Photos 
Use photos showing the damage to the building or the results of the damage at the 
scene. Include as many photos as you have available. For buildings, include exterior 
and interior shots. Interior shots should be taken to help establish the cause of the fire; 
for example, photos that establish the ignition source, the fuel ignited, and factors that 
brought them together. 
Suggested types of interior photos: 

 Large shiny char blister, indicating fast fires and the presence of ignitable 
liquids 

 Small, flat, dull blisters, characterizing slow accidental fires 
 Charred “V” patterns on a vertical surface. The width of the “V” pattern 

suggests the intensity of the fire, a wider “V” indicating a more intense fire. 
 Spalled concrete floor slabs, which are indicative of ignitable liquid fires 
 Depth of char in combustible materials, which helps determine the time of fire 

initiation 
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Additional Items 

1. Written handout material containing: 
• Conclusions about the cause of the fire and how it is characterized; causes 

are characterized as natural, unintentional, incendiary or 
unknown/undetermined. 

• Narratives of strategies and tactics of the fire attack or incident 
management 

• Reasons for the extensive loss or the successful control of the fire; for 
example, indicate what was done to decrease property loss, why some 
tactics were effective, and why others were not. 

2. A PowerPoint presentation can be used to integrate the hand out information and 
your simulation stages. For instructions on how to incorporate simulations into 
PowerPoint, see page 91 Importing a Simulation to PowerPoint 

 
 

Note:  It is a good idea to link these materials with the simulation. If you use 
Word to create your handouts, save the Word document with the same name 
that you use for the simulation itself and save it in the same folder in which 
you save the simulation. This will make it easier for you to find and use the 
appropriate materials as you add more simulations and handout materials. 
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Importing a Simulation to PowerPoint 
 
Simulations can be imported into a PowerPoint presentation and played from within 
the presentation. 
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To import a simulation: 

1. On the Insert menu, point to Movies and Sounds, and then click Movie from 
File. 

 

2. Navigate to the location of the simulation. 
3. Select the .wmv file corresponding to the stage you want to insert and click 

OK. 

 

4. Select the method for starting the movie – Automatically or When Clicked. 
5. To set the timing between slides, highlight a slide. 
6. On the Slide Show menu, click Slide Transition. 

 

Iluminar Technologies, Inc. StageIT 92  



Using StageIT 

7. In the Advance Slide group, select Automatically after and enter the time to 
wait before advancing to the next slide. To use the same delay for all slides, 
click Apply to All Slides.  

 
 

8. Save the presentation. 
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 Chapter 

8 Chapter 8 – Troubleshooting 
StageIT    

 
Technical Support: 1-800-755-1440   ext 5 
www.action-training.com/support.asp 

 

Problem: Video Problems 
  

• Video does not play properly.  
• Your stages do not render and play properly on your screen in StageIT 

Instructor 
• Your stages don’t play at all on your screen in StageIT Student. You see a 

solid black image. 
 
Explanation:  
 

You are probably experiencing a hardware driver issue with your video display 
adapter, or your display adapter is not capable of providing hardware video 
acceleration for DirectX processes. Perform only as many of the following 
steps as you need to achieve proper functionality. 

 
Solution: 
 

1. Check with the hardware manufacturer of your video display adapter and make 
sure that the drivers for your video adapter are current. Details for updating the 
driver vary, but the following set of steps should serve as a general guideline 
for updating the driver for your system. Please check your system and video 
display adapter documentation for more specific instructions. 

  To update your display adapter: 

1. Right-click My Computer and select Manage. 
2. Under System Tools, click Device Manager. 
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3. Click the plus sign next to Display adapters. 
4. Right-click on the adapter and select Update Driver. 
5. When the Update Hardware Wizard opens, click Yes, this time only and 

click Next. 
6. Click Install the software automatically and click Next. 
Your computer will search for an updated driver for the device and will install 
it. 

Note: You may need to visit the manufacturer website to download the 
updated driver. 

  
2. Reduce hardware acceleration by performing the following steps. DirectX 

calls will no longer be accelerated 
  

a. Right-click on the desktop and click Properties. 
b. Click the Settings tab. 
c. Click Advanced. 
d. Click the Troubleshoot tab. 
e. Drag the Hardware Acceleration pointer to “Disable all DirectDraw and 

Direct3D accelerations…" 
f. Click OK twice. 

 
3. If your video still doesn’t play correctly, do the following: 

a. Start StageIT Instructor. 
b. On the Edit menu, click Options. 
c. In the Video Screen Rendering group, click Basic. 
d. Click OK. 

  
If you are still having problems with video rendering and display on your computer, 
please call technical support (1-800-755-1440 ext 5) for further assistance.  
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Problem: Restoring Licenses  
 

• Current license file needs to be replaced 
 
Explanation:  
 

You may need to restore your license file because it has become damaged or 
corrupted. 

 
Solution: 
 

1. Save the license file on your hard drive in a location you can access. 
2. Reopen the license manager by choosing the File menu, click License 

Management 
3. Click Install License File. 
4. Click Browse, navigate to the location where you saved the license file, click 

the file name, and click Open. 
5. Click Install License File. 
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